Online Banking
User Guide
Updated 9/24/2021
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>Supported Browsers</td>
<td>7</td>
</tr>
<tr>
<td>Browser Support Alert</td>
<td>7</td>
</tr>
<tr>
<td>Device Support</td>
<td>7</td>
</tr>
<tr>
<td>Login Tips</td>
<td>8</td>
</tr>
<tr>
<td>Chrome: how to delete cookies and passwords in Chrome on a Windows or Mac computer</td>
<td>8</td>
</tr>
<tr>
<td>Firefox: how to delete cookies and passwords in Firefox on a Windows or Mac computer</td>
<td>9</td>
</tr>
<tr>
<td>Safari: how to delete cookies and passwords in Safari on a Mac computer</td>
<td>9</td>
</tr>
<tr>
<td>Internet Explorer: how to delete cookies and passwords in Internet Explorer for Windows 10, Windows 8.1, and Windows 7 on a Windows PC</td>
<td>9</td>
</tr>
<tr>
<td>Edge: how to delete cookies and passwords in Microsoft Edge on a Windows PC</td>
<td>9</td>
</tr>
<tr>
<td>Logging into Online Banking</td>
<td>10</td>
</tr>
<tr>
<td>Forgot Password</td>
<td>11</td>
</tr>
<tr>
<td>First Time Log On - New User Registration</td>
<td>12</td>
</tr>
<tr>
<td>Online Banking Header</td>
<td>14</td>
</tr>
<tr>
<td>Messages</td>
<td>14</td>
</tr>
<tr>
<td>Settings</td>
<td>14</td>
</tr>
<tr>
<td>Log Out</td>
<td>15</td>
</tr>
<tr>
<td>Online Banking Menu (Site Navigation)</td>
<td>15</td>
</tr>
<tr>
<td>Dashboard</td>
<td>15</td>
</tr>
<tr>
<td>Accounts</td>
<td>16</td>
</tr>
<tr>
<td>News and Information</td>
<td>16</td>
</tr>
<tr>
<td>Help</td>
<td>17</td>
</tr>
<tr>
<td>Recent Activity</td>
<td>17</td>
</tr>
<tr>
<td>Future Activity</td>
<td>18</td>
</tr>
<tr>
<td>Accounts Widget</td>
<td>19</td>
</tr>
<tr>
<td>Account Transaction History</td>
<td>20</td>
</tr>
<tr>
<td>Transaction Searching</td>
<td>20</td>
</tr>
<tr>
<td>Transaction Details</td>
<td>21</td>
</tr>
<tr>
<td>Transaction Categories</td>
<td>21</td>
</tr>
<tr>
<td>Account Details (Deposit Accounts)</td>
<td>22</td>
</tr>
</tbody>
</table>
Bill Pay

Bill Pay Dashboard

Adding a Payee

Making a Payment

Managing a Payee

Activity

eBills

Set up eBills

Manage eBills

MultiPay

Scheduled

History

Message Center Widget

Inbox

Compose a New Message

Reply to a Message

Message Actions

Sent Tab

Deleting a Sent Message

More Widget Options

Check Services

Stop Payment

Placing a Stop Payment

Reorder Checks

Budgets Widget

Creating a Budget

Budget Summary

Budget Spending

Income

Transactions

Settings

Business Admin Widget
Roles ........................................................................................................................................... 66
Creating a Role .......................................................................................................................... 66
Editing a Role ............................................................................................................................ 67
Delete a Role ................................................................................................................................ 67
Permissions .................................................................................................................................. 67
Assign Role Permissions ............................................................................................................. 68
Accounts and Limits ................................................................................................................... 69
Edit Account Permissions .......................................................................................................... 69
Remove Accounts ....................................................................................................................... 70
Limits ............................................................................................................................................ 70
Adding Limits to a Role ............................................................................................................... 70
Sub User Management ................................................................................................................ 71
Create a New Sub User .................................................................................................................. 71
Editing a Sub User ........................................................................................................................ 72
Edit a Sub User’s Contact Information ....................................................................................... 72
Change a Sub User’s Role ............................................................................................................ 72
Reset a Sub User’s Password ...................................................................................................... 72
Reset a Sub User’s Security Questions ....................................................................................... 72
Delete a Sub User ........................................................................................................................ 73
Transaction Authorizations ........................................................................................................ 73
Authorize a Transaction .............................................................................................................. 73
Authorization Alerts .................................................................................................................. 74
Locations Widget ....................................................................................................................... 74
Calculator and Calendar Widget ................................................................................................. 74
Statement & Notifications Widget ............................................................................................. 74
Checking Tracker Widget .......................................................................................................... 75
Quick Apply Widget ................................................................................................................... 76
Applying for an Account ............................................................................................................. 76
Applying for a Mortgage ............................................................................................................ 77
Card Management Widget ........................................................................................................ 78
Freezing or Unfreezing a Card ..................................................................................................... 78
Add Travel Notices ..................................................................................................................... 79
Ordering Replacement Card ........................................................................................................79
Courtesy Pay Widget................................................................................................................80
Overdraft Protection Widget ......................................................................................................80
  Setting up Overdraft Protection ..............................................................................................80
FICO Score ................................................................................................................................81
Alerts .........................................................................................................................................82
Settings .....................................................................................................................................83
  Profile .......................................................................................................................................83
  Security .....................................................................................................................................83
  Themes .......................................................................................................................................83
  Widget .......................................................................................................................................83
  Contact ......................................................................................................................................84
Accounts .....................................................................................................................................85
  Adding a Shared User ................................................................................................................85
Shared Access .............................................................................................................................85
Applications ..................................................................................................................................88
Frequently Asked Questions .......................................................................................................88
Introduction
Online Banking is an electronic product that Members use to manage, monitor, and move their money; it is an electronic representation of PMCU's commitment to service and quality.

Supported Browsers
In general, PMCU online banking operates on the last two versions of supported browsers. This ensures PMCU online banking is up to date with the latest browser releases and also ensures browsers are as secure as possible.

- Google Chrome: Latest 2 versions (87.x, 88.x)
- Firefox: Latest 2 versions (83.x, 84.x)
- Microsoft Edge: Latest 2 versions (87.x, 88.x)
- Safari: Last 2 major versions or 1 major version if over 1 year old (El Capitan 11.x, Sierra 12.x, High Sierra 13.x, Mojave/Big Sur 14.x)
- Chrome for Android: Last 2 major versions (87.x, 88.x)
- Mobile Safari for IOS: Last 2 major versions (13.x, 14.x)

Browser Support Alert
The browser support alert (popup that automatically displays if the end user is not using a known supported browser) has been configured to accommodate a broader browser version spectrum. It does not popup and alert end users based on the official supported browsers list above.

Device Support
PMCU online banking operates on Windows and Apple OS X computing platforms as well as Android and IOS mobile platforms.

- Windows: versions that are still supported by Microsoft and support a browser listed above
- OSX: versions that are still supported by Apple and support a browser listed above
- Android: v6.0 and above
- IOS: the last 2 major releases (13.x, 14.x)
Login Tips

Clearing cookies and old passwords can assist in resolving issues logging into online banking. The following are general steps to clear your computer. These steps may change based on the version of the browser and computer used.

**Important:** If these steps do not help, please try using a different browser as this often resolves login issues.

Chrome: how to delete cookies and passwords in Chrome on a Windows or Mac computer

1. Open Chrome.
2. In the top right corner of the browser you will see three dots, which indicates a settings menu.
3. Scroll down to the bottom of the page and click on “Advanced.”
4. Click on the section “Clear browsing data.” You can complete the deletion by clicking “Clear data.” You can also clear your cache, which is where your computer stores previously viewed websites so they can be loaded faster on future visits.
5. In Autofill select “Passwords” and remove any saved passwords for the previous online banking
Firefox: how to delete cookies and passwords in Firefox on a Windows or Mac computer
   1. Open Firefox on your computer.
   2. In the upper right-hand corner of the browser, click the menu bars which look like three parallel lines, open up Preferences, and click the “Privacy and Security” tab.
   3. In Cookies and Site Data select “Clear Data”
   4. In Logins and Passwords “Remove” any saved Passwords for the previous online banking
   5. Double check your selections to make sure that other items you want to keep are not selected, and then hit “Clear now.”

Safari: how to delete cookies and passwords in Safari on a Mac computer
   1. Open Safari on your computer.
   2. Open up Clear History and click Clear History button to clear cookies and other website data
   3. In Passwords Remove any saved Passwords for the previous online banking

Internet Explorer: how to delete cookies and passwords in Internet Explorer for Windows 10, Windows 8.1, and Windows 7 on a Windows PC

**Important:** Internet Explorer is not compatible with PMCU Online Banking

Edge: how to delete cookies and passwords in Microsoft Edge on a Windows PC
   1. Open Edge.
   2. In the top right corner of the browser you will see three dots, which indicates a settings menu.
   3. Click on Privacy and Security
   4. Click on Choose what to clear in the section “Clear browsing data.” You can complete the deletion by clicking “Clear”.
   5. In Passwords and Autofill select “Manage Passwords” and remove any saved passwords for the previous online banking
Logging into Online Banking

1. Enter your User Name and Password in the login box on the PMCU website
2. Click Sign In
3. Members will be directed to the password page to enter their password
4. A Member will enter their Password and then click "Log In"
   a. The “Password” must contain letters, numbers, and symbols.
5. Members may need to be prompted to complete an authentication
   a. Choose how to receive one-time passcode
      i. Email
      ii. SMS (Text)
      iii. Phone
   b. Click Send code
6. Enter one-time passcode
Forgot Password

1. Click Reset Password option
2. Select how you want to receive your temporary password
   - Email
   - SMS (Text)
   - Other – Members will see this message when selecting Other

3. Enter temporary password on temporary password page
4. Click Log In
5. Create new password
   a. Your password must be at least eight characters in length, contain at least one lowercase letter, at least one uppercase letter, and at least one number.

Note: If you should need assistance logging in, please contact us at 303-657-7000

First Time Log On - New User Registration

The first time a new user logs onto Online Banking, they will create an Online Banking User Name and Password.

To register for Online Banking, click on the “Register” link that appears under the User Name Login box.
After the member has clicked “Register,” they will be presented with an Electronic Services Agreement Disclosure. To proceed with using the Online Banking system, the member must accept the agreement by clicking on the check box at the bottom of the page and clicking “I agree” and continue.

1. Next, enter the requested information in the appropriate fields and click Continue.
   a. Account Number
   b. SSN/TaxID
   c. Birth Date
2. Create a Username (Min 6 characters and max 30 characters)
   a. Usernames can be letters, numbers, special characters or a combination.
      i. Only the following special characters can be used: ^[_][._]{,}$
   b. Usernames cannot contain a member’s: Social Security Number/Tax ID, Member Number or Account Number
3. Click Check Availability
4. Select how temporary password will be delivered
   a. Email
   b. SMS (Text)
   c. Other (Not available for SMS or emails not currently in the system)
5. Click Continue
6. Enter temporary password received
7. Create New Password (Min 8 characters and max 32 characters)
   a. Your password must be at least eight characters in length, contain at least one lowercase letter, at least one uppercase letter, and at least one number.
   b. Passwords are case sensitive
8. Click Continue
9. Confirm Contact Information and click continue

10. Select which accounts to display
11. Click Finish Registration

**Online Banking Header**

The header will contain the members first and last name. Clicking on name in the profile will display three options for a member.

- Messages
- Settings
- Log Out

**Messages**

Messages will open the message center. Members can create messages to send to the credit union for help, or can view any message responses for any messages they have sent.

**Settings**

The Settings is where the member can configure their profile, security, theme, widgets, contact information, notifications, and accounts.
Log Out

The “Log Out” button should be used when the Member has completed their Online Banking session; by clicking on “Log Out” the Member signs out of Online Banking and securely ends their session.

Online Banking Menu (Site Navigation)

Within Online Banking a Member can select any widget option to navigate to the selected item. The widget bar can be customized in settings. Please review the settings section for more details.

Dashboard

The Dashboard is a required widget because it is the landing page in Online Banking. The dashboard will display any account alerts (Pending External Account Verification, Payment and Delinquent Loan Reminders) on all accounts the member has, such as deposit accounts, loans, mortgages, or retirement accounts (IRA). On the right side of the page recent and future activity will be displayed. Quick links for the following will be displayed as well:

- Apply for a loan
- Loan and Account Rates
- Financial Calculators
- Credit Card Reward Redemption
- Apply for a Mortgage
- Make My Loan Payment
Online Banking – User Guide

Accounts
Members can click on any of the listed accounts showing in the dashboard. Clicking on an account will take the member to the accounts widget. If a member selects pay for a loan it will take them to the transfer widget to start the payment. Members can click on the gear icon to choose which accounts will display in the dashboard, at least one account must be selected.

Dashboard Settings
Accounts
Choose the accounts you’d like to appear on your dashboard. You must select at least one account.

Checking
- MNS ACCOUNT
- CHECKING

Savings
- MONEY MARKET
- SIMPLE HSA
- SAVINGS

Retirement Accounts
- SAVINGS

Mortgages
- Mortgage Loan
- Mortgage Loan

News and Information
Important information or news will be displayed, simply by clicking on the news and information button.
Help
The help button will be displayed on every page the member visits. Depending on the page the member is on, it will display different help options. The help button will be in upper right side of the page with a “?” and the word Help.

Recent Activity
The recent activity option automatically displays the last 7 days of recent account activity; however, this option can be customized based on the members preference.

- Transfers
- New Messages
- Account Alerts
- Login Activity
- Savings Goals Completed
- Bill Payments
- New Payees
Clicking on the gear icon, members can choose the amount of days for recent activity and which items to display.

**Dashboard Settings**

**Recent Activity**
You can choose how many days of recent activity and what types of information you’d like displayed on your dashboard.

- **How many days?**
- **What to Display**
  - Transfers
  - New Messages
  - Account Alerts
  - Signon Activity
  - Savings Goals Completed
  - Bill Pay
  - New Payees

Clicking on the gear icon, members can choose the amount of days for recent activity and which items to display.

**Future Activity**

The Future activity option automatically displays the last 7 days of future activity; however, this option can be customized based on the members preference.

- Transfers
- Pending Transactions
- Auto Draft Payments
- Bill Payments

Clicking on the gear icon, members can choose the amount of days for future activity and which items to display.

**Dashboard Settings**

**Upcoming Activity**
You can choose how many days of upcoming activity and what types of information you’d like displayed on your dashboard.

- **How many days?**
- **What to Display**
  - Transfers
  - Pending Transactions
  - Auto Draft Payments
  - Bill Pay

Clicking on the gear icon, members can choose the amount of days for future activity and which items to display.
Accounts Widget

The Accounts widget displays the member’s accounts and provides the member the ability to:

- View current and available balances for all of their accounts
- View any recent alerts or pending transactions for those accounts
- View transaction history for their accounts
- Search and filter for specific transactions
- View account details
- View account analytics (account balance history, spending breakdown)
- View balance history for their accounts
- Print Transactions
- Download transactions

Accounts displayed will be by the following:

- Checking
- Savings
- Retirement Accounts (IRA)
- Loans
- Mortgage
**Account Transaction History**

Transaction history allows the member to view their transaction history for a specific account. Selecting an account in the left pane displays account history (transactions) in the adjacent pane. Pending transactions are separated and displayed above posted transactions. Pending transactions are reflected in an account's available balance.

**Transaction Searching**

Use the search box to search for keywords in transaction history. Select the funnel icon next to the search box for more advanced search options.

Advanced Search Options available are:

- **Keywords**
- **Date**
- **Category**
- **Transaction Amount**
  - Range
- **Type**
  - ACH
  - ATM
  - Bill Pay
  - Card
  - Check
  - Dividends
  - Fees
  - Interest
  - Online Banking
  - Other
  - Payroll
  - POS
  - Retail ACH
  - Transfer
  - Wire
  - Withholding
- **Credit or Debit**
- **Check Number**
  - Range
Transaction Details
Clicking on any transaction will show the transaction summary. The following will appear in the summary:

- Description
- Amount
- Help
  - Can click and send a message to the Credit Union for assistance
- Account
- Category

Transaction Categories
Transactions can be categorized and edited per the preference of the member. This can be done by simply clicking add a category or if a transaction has been labeled, click on the name of the category. Once the category box appears choose the category you would like.

*Note: Any transactions categorized or edited will only be visible to the member who customized the transaction.*
Account Details (Deposit Accounts)
Members can view additional account details by selecting an account in the left pane and then choosing the Account Details tab at the top of the right pane. The following will be displayed:

- Nickname
- Available Balance
- Current Balance
- MICR Account Number
  - Used for Direct Deposits or Payments to Merchants
- Interest Paid Year to Date

Clicking the printer icon will print the page.

Account Details (Loans)
Members can view additional loan details by selecting a loan in the left pane and then choosing the Account Details tab at the top of the right pane. Some or all of the following will be displayed:

- Nickname
- Ledger Balance
- Escrow Balance
- Available Balance
- Current Balance
- Past Due Amount
- Next Payment Amount
- Principal and Interest Amount
- Next Payment Date
- Interest Paid Last Year
- Interest Rate
- MICR Account Number
- Credit Limit Amount
- Current Loan Payoff Amount
- Last Statement Balance
- Calculate Loan Payoff (Installment Loans Only)

*Note: Some of the details listed above will not appear based on the type of loan.*
# Mortgage Loan

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Account Details</th>
<th>Analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>NICKNAME</td>
<td>Mortgage Loan</td>
<td></td>
</tr>
<tr>
<td>LEDGER BALANCE</td>
<td>$199,750.00</td>
<td></td>
</tr>
<tr>
<td>ESCROW BALANCE</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>PAST DUE AMOUNT</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>NEXT PAYMENT AMOUNT DUE</td>
<td>$1,300.00</td>
<td></td>
</tr>
<tr>
<td>PRINCIPAL AND INTEREST AMOUNT</td>
<td>$1,300.00</td>
<td></td>
</tr>
<tr>
<td>NEXT PAYMENT DATE</td>
<td>01/01/2014</td>
<td></td>
</tr>
<tr>
<td>INTEREST PAID YEAR TO DATE</td>
<td>$1,550.00</td>
<td></td>
</tr>
<tr>
<td>INTEREST RATE</td>
<td>4.500%</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Available Balance</th>
<th>Current Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0.00</td>
<td>$199,750.00</td>
</tr>
</tbody>
</table>
Calculate Loan Payoff (Installment Loans Only)
Members who have an installment loan will be able to calculate a payoff for their loan in the account details section. Members can enter a date in the calculate loan payoff section and a payoff will generate appropriately.
Editing Account Details

Members can create nicknames, color code, or hide an account. This can be done by clicking on the pencil icon next to the account name. Once you have completed any changes, click save.

*Nicknaming an account within Online Banking and will not appear on Member Statements, Notices, or other Credit Union documentation.*

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Account Details</th>
<th>Analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>EARN BIG FREE CHECKING</td>
<td>Current Balance</td>
<td>Available Balance</td>
</tr>
<tr>
<td>$18.16</td>
<td>$18.16</td>
<td></td>
</tr>
</tbody>
</table>

**Withdrawal Details**

**Account Details**

<table>
<thead>
<tr>
<th>Account</th>
<th>EARN BIG FREE CHECKING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nickname</td>
<td>EARN BIG FREE CHECKING</td>
</tr>
<tr>
<td>Color</td>
<td></td>
</tr>
</tbody>
</table>

**Hide Account**

You may hide this account from widgets, such as Dashboard, My Accounts, Transfers, etc. Don’t worry, you will not lose any transaction data and it will still be there should you decide to come back and unhide this account.

Clicking on the printer icon will print the current page.

Account Analytics

Members can view account analytic details by selecting an account in the left pane and then choosing the Account Analytics tab at the top of the right pane. Members will be able to view balance or spending analytics for the specific account.

- **Balance**
  - Displays a graph of the selected account’s balance over the specified date range.
- **Spending (Only for Deposit Accounts)**
  - Displays a breakdown of categorized expenses over the specified date range
- **Timeframe**
  - 1 Month
  - 3 Months
  - 6 Months

Clicking on the printer icon will print the current page.
EARN BIG FREE CHECKING

Current Balance: $1,128.40
Available Balance: $1,128.40

Transactions  Account Details  Analytics

Balance History  Spending

1 Month  3 Months  6 Months

Account Balance History

Spending Breakdown

- Bills & Utilities: $150.88
- Food & Dining: $138.45
- Shopping: $28.27
- Auto & Transport: $15.00

(does not include Uncategorized spending)
Total: $332.60
Export Transactions

You can export your transactions by clicking on the download icon at the top of the list of transactions. You can download a comma-separated value file (CSV), a file formatted for Microsoft Money, a file formatted for QuickBooks, or a file formatted for Quicken. You can select the download version type in the Format dropdown box.

Exporting Transactions

1. Select Download Format
2. Select Start Date
3. Select End Date
4. Select Account(s)
5. Click Download

Download Transactions

Downloading to Quicken
This method allows you to update all of your accounts with one click. This service supports the latest version as well as the two previous versions of Quicken. This includes downloading financial data from financial institutions, and technical support.

Downloading to your desktop
You can download account information to your desktop as a comma-delimited file or comma-separated value (CSV) file and import it into Microsoft Excel and most other spreadsheet programs on Windows or Mac.

Download Format

Select
CSV (Comma-Separated Value)
QFX (Open Financial Exchange)
QFX (Quicken WebConnect)
QBO (QuickBooks)
Quicken and Quickbooks Tips

Important: Deactivating the old connection to Premier Members and re-establishing it is a critical step in the process. Also, ensure that your accounts are mapped to the existing accounts in Quicken or QuickBooks and new accounts are not created inadvertently.

Please refer to the Export Transactions section in this guide for manual file downloading to Quicken and QuickBooks. The QuickBooks desktop app does not support automated updates.

Contact information for Quicken and QuickBooks for additional support:

QuickBooks: 1-800-446-8848, Quicken: 1-888-311-7276

Quicken Windows Express Web Connect

1. Deactivate online banking connection for accounts connected to the financial institution that is requesting this change.
   a. Choose Tools > Account List.
   b. Click Edit on the account to deactivate.
   c. In Account Details, click Online Services.
   d. Click Deactivate. Follow prompts to confirm deactivation.
   e. Click the General tab.
   f. Delete Financial Institution and Account Number information. Click OK to close window.
   g. Repeat steps for any additional accounts that apply.

2. Reconnect the online banking connection for your accounts.
   a. Choose Tools > Account List.
   b. Click Edit on the account you want to activate.
   c. In Account Details, click Online Services and then choose Set up Now.
   d. Type your institution’s name in the search field and click Next.
   e. Enter your financial institution credentials.

Express Web Connect uses the same credentials you use for your institution’s online banking login.

Important: If your credentials do not work, contact us.

Ensure you associate the accounts to the appropriate accounts already listed in Quicken. Select Link to an existing account and select the matching accounts in the drop-down menu.

Important: Do NOT choose “Create a new account” unless you intend to add a new account to Quicken. If you are presented with accounts you do not want to track in this data file, choose Ignore – Don’t Download into Quicken or click Cancel.

After all accounts have been matched, click Next and then Done.
Activate the online banking connection for accounts connected to the financial institution that is requesting this change.

1. Click your account in the Accounts list on the left side.
2. Choose Accounts > Settings.
3. Select Set up transaction download.
4. Enter your financial institution name in the search field, select the correct option and click Continue.
5. Enter your financial institution credentials.
   - Express Web Connect uses the same credentials you use for your institution’s online banking login.

Important: If your credentials do not work, contact us.

6. In the “Accounts Found” screen, ensure you associate each new account to the appropriate account already listed in Quicken. Under Action, choose Link to pick your existing account.

Important: Do NOT select “ADD” in the Action column unless you intend to add a new account to Quicken.

7. Click Finish.
Quicken Windows Web Connect

1. Deactivate online banking connection for accounts connected to financial institution that is requesting this change.
   a. Choose **Tools > Account List**.
   b. Click **Edit** on the account to deactivate.
   c. In Account Details, click **Online Services**.
   d. Click **Deactivate**. Follow prompts to confirm deactivation.
   e. Click the **General** tab.
   f. Delete Financial Institution and Account Number information.
   g. Click **OK** to close window.
   h. Repeat steps for any additional accounts.

2. Reconnect online banking connection for accounts that apply. a. Download a Quicken Web Connect file from your financial institution’s online banking site.
   a. In Quicken, choose **File > File Import > Web Connect (.QFX) File**.
   b. Use the import dialog to select the Web Connect file you downloaded. An “Import Downloaded Transactions” window opens.
   c. Choose **Link to an existing account**. Select the matching account in the drop-down menu. Associate the imported transactions to the correct account listed in Quicken.
   d. Repeat this step for each account you have connected to this institution.
Quicken Mac Web Connect

Activate online banking connection for accounts connected to financial institution that is requesting this change.

1. Select your account under the Accounts list on the left side.
2. Choose Accounts > Settings.
3. Select Set up transaction download.
4. Enter your financial institution name in the search field, select the correct option and click Continue.
5. Log into your financial institutions online banking site and download your transactions to your computer.

Important: Take note of the date you last had a successful connection. If you have overlapping dates in the web-connect process, you may end up with duplicate transactions.

6. Drag and drop the downloaded file into the box titled Drop download file. Choose Web Connect for the “Connection Type” if prompted.
7. In the “Accounts Found” screen, ensure you associate each new account to the appropriate account already listed in Quicken. Under the Action column, click Link to pick your existing account.

Important: Do NOT select “ADD” in the Action column unless you intend to add a new account to Quicken.

8. Click Finish.
**Tax Information**

Members will be able to view dividends earned on deposit accounts, interest paid on loans, withholdings, fees, and penalties. This can be done by clicking on the tax information tab next to accounts.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Tax Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Year-to-Date Totals</strong></td>
<td></td>
</tr>
<tr>
<td>PRIMARY SHARE</td>
<td>$0.00</td>
</tr>
<tr>
<td>6002 CHECKING</td>
<td>$0.00</td>
</tr>
<tr>
<td>MONEY MARKET</td>
<td>$0.00</td>
</tr>
<tr>
<td>SINGLE HSA</td>
<td>$0.00</td>
</tr>
<tr>
<td>6003 SAVINGS</td>
<td>$0.00</td>
</tr>
<tr>
<td>6003 SAVINGS</td>
<td>$0.00</td>
</tr>
<tr>
<td>Mortgage Loan</td>
<td>$0.00</td>
</tr>
<tr>
<td>Mortgage Loan</td>
<td>$1,500.00</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$1,500.00</td>
</tr>
<tr>
<td><strong>Dividends Earned</strong></td>
<td></td>
</tr>
<tr>
<td>MONEY MARKET</td>
<td>$0.00</td>
</tr>
<tr>
<td>SINGLE HSA</td>
<td>$0.00</td>
</tr>
<tr>
<td>6003 SAVINGS</td>
<td>$0.00</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$0.00</td>
</tr>
<tr>
<td><strong>Interest Paid</strong></td>
<td></td>
</tr>
<tr>
<td>ACCOUNT</td>
<td>2019 INTEREST</td>
</tr>
<tr>
<td>Mortgage Loan</td>
<td>$0.00</td>
</tr>
<tr>
<td>Mortgage Loan</td>
<td>$0.00</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
Transfer Widget

The Transfer widget provides the ability to perform an immediate transfer of funds, pay loans, and schedule future or recurring transfers. There are two options to start a transfer: Quick Transfer and Classic Transfer.

Quick Transfer

Quick Transfer offers a streamlined method for members to submit immediate one-time transfers.

1. Click the account you want to transfer from.
2. Click the amount to transfer from the list of convenient predetermined amounts, or by entering a specific amount in the custom amount section.
3. Click the account you want to transfer to.
   a. Members can make transfers to and from internal and external accounts. Additionally, members can make cash advances and loan payments. However, they cannot select an external account as both the to and from source.
4. Click the Submit Transfer button.
5. The Confirm Transfer window will display.
6. Review the transfer details.
7. Click the Confirm Transfer button.
8. A Success message will display, to confirm your transfer has been completed.
9. Click on the X icon at the top right of the screen to close the Success message screen (to exit out)

10. Click on one of the option buttons at the bottom of the screen to either Make Another Transfer (which will bring you back to the Quick Transfers tab) or to Go To Transfer Activity (which will bring you to the History tab).

**Classic Transfer**
The Classic transfers tab allows members to perform both one-time and recurring transfers, as well as loan payments. Members can add external accounts from another financial intuition, or Member to Member accounts for transfers. Scheduled and recent transfer activity up to the five most recent transfers, within the next 30 days. There are links that take the member to the Scheduled or History tabs to see full details.

**Completing a Transfer**
1. Click the account you want to transfer from.
2. Click the account you want to transfer to.
   a. Members can make transfers to and from both internal and external accounts. Additionally, members can make cash advances and loan payments.
3. Select the Amount you want to transfer.
4. Choose the Date (or Start Date) you want the transfer to take place.
5. Select the Frequency the transfer will repeat on. (See Frequencies)
6. Select the Ending date of the recurring transfer, if prompted. (Depending on which frequency you chose.)
7. Add memo (optional).
8. Click the Submit Transfer button.

Members can set up transfers or payments based on any of the following four transfer scenarios:

- **One-time immediate transfer**
  - Creates a one-time, immediate transfer. When a transfer is executed, a confirmation screen will appear to confirm the details of the transfer
- **One-time future-dated transfer**
  - Specify a future date as to when that transfer should execute.
- **Immediate recurring transfer**
  - Create an immediate recurring transfer, specify the frequency and when the recurring transfer should end.
- **Future-dated recurring transfer**
  - Specify a future date as to when a transfer should execute and specify the frequency and when the recurring transfer should end.
Recurring Transfer Options
The following frequencies can be selected for a recurring transfer:

- Yearly
- Monthly
- Semi-Monthly
- Weekly
- Daily
- Biweekly
- End of Month
- Quarterly
- Every Other Month
- Every 4 Weeks
- Every 6 Months

The following recurrence end options can be selected:

- Never
- On Certain Date
- After X (number of) Occurrences

Loan Payments
Completing a Payment
1. Click the account you want to transfer from.
2. Click the loan you want to make a payment to.
   a. Members can make payments from both internal and external accounts.
3. Select any of the following payment options:
   - Current Balance
     o The current balance of the loan will be paid
   - Last Statement Balance
     o The balance from the previous statement will be paid
   - Minimum Due
     o The minimum amount due on the loan will be paid
   - Past Due Amount
     o The past due amount will be paid
   - Pay Off
     o Will pay off the loan in full
   - "Other"
     o Any dollar amount can be entered to make a payment
4. Choose the Date (or Start Date) you want the payment to take place.
5. Select the Frequency the payment will repeat on. (See Frequencies)
6. Select the Ending date of the recurring payment, if prompted. (Depending on which frequency you chose.)
7. Add memo (optional).
8. Click the Submit Transfer button.

<table>
<thead>
<tr>
<th>From Account</th>
<th>To Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>EARN BIG FREE CHECKING</td>
<td>HELOC</td>
</tr>
<tr>
<td>$1,000.00</td>
<td>$12,000.00</td>
</tr>
</tbody>
</table>

Don’t see the account you want to transfer to or from? If you need payoff information, please visit the Details tab on your loan:
- Transfer to another PMCU member's account
- Add an external account

Amount:
- Current Balance $12,000.00
- Last Statement Balance $0.00
- Minimum Due $100.00
- Past Due Amount $0.00
- Pay Off – Please Call Us For Payoff Statement $12,246.86
- Other

Total $0.00

Date
02/25/2021

Frequency
One Time

Memo (Optional)
Enter a Memo

Submit Transfer
Mortgage Payments

Completing a Payment

1. Click the account you want to transfer from.
2. Click the mortgage you want to make a payment to.
3. Select the Regular Payment.
   a. Enter additional principal amount (Optional).
      i. External Accounts will not be able to select this option. Please see additional instructions on the next page.
4. Choose the Date (or Start Date) you want the payment to take place.
5. Select the Frequency the transfer will repeat on. (See Frequencies)
6. Select the Ending date of the recurring transfer, if prompted. (Depending on which frequency you chose.)
7. Add memo (optional).
8. Click the Submit Transfer button.

From Account

EARN BIG FREE CHECKING

To Account

Mortgage Loan

Don’t see the account you want to transfer to or from? If you need payoff information, please visit the Details tab on your loan.

- Transfer to another PMCU member’s account
- Add an external account

Amount

Regular Payment
$1,000.00

Additional Principal(Optional)

$0.00

Total

$1,000.00

Date

02/04/2021

Frequency

One Time

Memo (Optional)

Enter a Memo

Submit Transfer
Adding Additional Principal to a Mortgage Payment (External Account)
The additional principal option will not display for mortgage payments made from an external account. Once you have created your mortgage payment, please follow the steps below to add additional principal to your mortgage payment.

1. Create Mortgage Payment
2. Click Scheduled
3. Click on pencil icon
4. Enter dollar amount in “Additional Principal”
5. Click Save
Member-to-Member Transfers
Members have the ability to transfer funds to another members account at the Credit Union. *No account balances will be displayed once another member’s account has been added.*

Members have the ability to set up member-to-member transfers to other members who also bank with the Credit Union. The member-to-member transfer allows the ability for an account to be transferred to *NOT* from. An email will be sent to the member notifying them of the connection.

**Note:** *No account balances will be displayed once another member’s account has been added.*

Adding an Account Number for Member-to-Member Transfer
1. Click Transfers
2. Click Classic tab
3. Click Add an Account to make a transfer
4. Click Send Money to another Premier Members CU member
5. Enter the Last Name or Business Name
6. Click Account
   a. Select Account Type
      i. Share Account or Loan Account
7. Enter the following information:
   a. Account number
   b. Share or Loan ID number
   c. Click “Save Account for Future Uses”
      i. At member’s discretion
   d. Enter Nickname for added account
8. Click Save

An email will be sent to both members notifying them of the connection.

External Accounts
Members can transfer money TO or FROM an Account they own at another financial institution using this option. Members requesting a relationship to an Account Outside of PMCU must be an owner on the Outside Account. Daily and monthly transfer limitations apply and transfers TO/FROM Accounts Outside of PMCU must be scheduled; immediate transfers are not available. Adding an external account be done within the classic transfer tab or in settings.

**Note:** *There is a daily limit of $10,000 dollars, weekly limit of $20,000 dollars and a monthly limit of $30,000.*

Adding External Accounts for Transfer

**Classic Transfer Tab:**
1. Click Transfers
2. Click Classic tab
3. Click add an account to make a transfer
   a. Member must read and agree to disclosures pop up
4. Select add an account manually
5. The Transfer to and from and External account window will display.
   a. Select an Account Type
   b. Valid Routing Number
   c. Account Number
   d. Nickname
   e. Click Save

6. Once set up, 2 micro deposits and a withdrawal will be sent to the external account, and will need to verify that $ amount.
   a. The micro deposits take 2-3 business days to appear
      i. This is how the system validates that this is your information/account at the external FI

7. Members can verify the micro deposit by doing the following:
   a. Click on Name in upper right-hand corner
   b. Click on settings
   c. Accounts
   d. Will be under ACH with a Pending status
   e. Click confirm and enter amounts
      i. Member will have 4 attempts to verify the micro deposits.
         1. If the member fails all four, they will need to start the process over again.

8. Once the account has been validated, the member can initiate a transfer.
9. The transfer is NOT immediate.
10. When the member sets up the transfer, the screen will tell them the date that the transfer is expected to occur on.
    a. The transfer will occur via ACH

**Settings:**

1. Click on your name in the upper right side of the page
2. Click Settings
3. Click on Accounts tab

4. Click Link an External Account
5. Select External transfer account
6. The Add Account at Another Bank window is displayed.
   a. Select an Account Type
   b. Valid Routing Number
   c. Account Number
   d. Nickname
   e. Click Save

7. Once set up, 2 micro deposits and a withdrawal will be sent to the external account, and
members will need to verify that $ amount.
   a. The micro deposits take 2-3 business days to appear
      i. This is how the system validates that this is your information/account at the 
         external FI
8. Members can verify the micro deposit by doing the following:
   a. Click on Name in upper right-hand corner
   b. Click on settings
   c. Accounts
   d. Will be under ACH with a Pending status
   e. Click confirm and enter amounts
      i. Member will have 4 attempts to verify the micro deposits.
         1. If the member fails all four, they will need to start the process over 
            again.
9. Once the account has been validated, the member can initiate a transfer.
10. The transfer is NOT immediate.
11. When the member sets up the transfer, the screen will tell them the date that the transfer is 
    expected to occur on.
    a. The transfer will occur via ACH

Viewing/Editing an ACH Account
Settings Option:
   1. Click on Name in upper right-hand corner
   2. Click on settings
   3. Go to Accounts
      a. Will be under ACH
   4. Click the pencil icon to view account details
More Widget Option:
   1. Click the More widget
   2. Select Widget Options
   3. Click Accounts
      a. Will be under ACH
   4. Click the pencil icon to view account details

Deleting an ACH Account
Settings Option:
   1. Click on Name in upper right-hand corner
   2. Click on settings
   3. Go to Accounts
      a. Will be under ACH
   4. Click the trash can icon to delete the account
More Widget Option:
   1. Click the More widget
   2. Select Widget Options
   3. Click Accounts
      a. Will be under ACH
4. Click the trash can icon to delete the account

Members will be able to link an external account to view balances, loans, and transactions. A member will not be able to conduct transactions with the linked external account.

**Linking an External Account at Another Financial Institution**

**Dashboard Widget**

1. Click Get Started in the Link External Accounts section of the dashboard widget
2. Search for your External Financial Institution
   a. As you start typing a list will generate
3. Select your Financial Institution
4. Enter the online user name and password for that financial institution
5. Click Submit
6. Click close if you are done or you may link another financial institution
Please enter your Wells Fargo HSA online account credentials.

User Name

Password

Re-enter Password

Visit your financial institution's site to retrieve or create your username and password. This will open a new window.

By providing your credentials, we verify in real time that you own the account you want to link. We then use this information to establish a secure connection with your financial institution.
Settings Option:

1. Click on Name in upper right-hand corner
2. Click on settings
3. Go to Accounts
4. Click Link an External Account
5. Select Link Accounts from Another Financial Institution
6. Search for your External Financial Institution
   a. As you start typing a list will generate
7. Select your Financial Institution
8. Enter the online user name and password for that financial institution
9. Click Submit
10. Click close if you are done or you may link another financial institution

Scheduled Tab

The scheduled tab allows members to view, edit, and delete all future-dated, one-time, and recurring transfers. Selecting a calendar date will filter the list of scheduled transfers specifically to the list of transfers scheduled for that day.

The scheduled tab defaults to display five transfers per page, however members can choose to display up to twenty transfers per page.

Members have the option to delete (cancel) one-time transfers, a single instance of recurring transfers, or the entire series. Clicking on the delete (trash can) icon a member can delete the transfer or cancel the next transfer in the series.
Note: In order to cancel the next transfer in a series the recurring transfer must have processed at least once.

Clicking on the penicil icon will allow members to edit the transfer based on the transfer type.

- **One-time Future-dated**
  - Amount
  - Start Date
  - Memo
  - Cancel Transfer Series

- **Recurring Future-dated**
  - Amount
  - Start Date
  - End Date
    - Never
    - On specific date
    - After (X) Occurrences
  - Memo
  - Cancel Transfer Series

- **Recurring Series Started Amount**
  - Amount
  - Memo
  - Cancel Transfer Series
History
Members can view transfer history, for both successful and failed transfers. The history tab defaults to display five transfers per page; however members can choose to display up to twenty transfers per page.

Members can view detailed information by clicking next to the status of the transfer.

Members can filter transfers by clicking any of the following:

- Date
- Amount
- From Account
- To Account
Members can do an advance search by clicking Filter and enter any of the criteria:

- Date
- Status
- From Account
- To Account

**Savings Goal**

Members are able to create savings goals and track their progress. Members can set up multiple goals per account and allocate funds to those goals in different ways. Each savings goal is associated with a savings account.

To add a new goal, select the account which you would like to create the goal. Your existing balance is automatically applied to the new goal.

1. Select the New Goal button to the right of your chosen account to create a new savings goal.
2. Name your goal.
3. The goal will be tied to the displayed account.
4. Select the category that best describes your goal.
5. Enter a dollar amount.
6. Upload an image that relates to your goal (optional).
7. Designate a date when you would like to reach your goal (optional).
8. Average Needed Monthly is the amount you will need to save each month to achieve your goal by the Target Date.
9. Select Save Goal.
Members can add funds, edit, or delete their goal by clicking on the appropriate button.

To add funds to a goal please do the following:

1. Click Add Funds
2. The “Add Funds to Goal” page will display
3. Enter a dollar amount
4. Select funding source
   a. Transfer from an account
5. Add funds

Clicking edit will allow a goal to be edited by any of the following:

- Goal Name
- Category
- Dollar amount
- Image
- Target Date

Once you have made your changes click Save Goal

Deleting a goal can be done by selecting delete and clicking yes.

Once you have met your goal, you can spend your savings by transferring your goal amount to your checking account(s). You can transfer all or part of your completed goal amount by selecting the Spend Funds button next to your completed goal.
Transfer Funds

Now that you've completed this goal, you can withdraw the funds from the associated savings account and deposit them into your checking account. After you complete this transfer, saving for this goal will resume until you delete it.

Name: Sony PSP game

Account: Bobby's Savings- 3832

Category: Electronics

Amount: 0.00 ($270.00 available to spend)

To Account: Select Account

The following will be displayed on the transfer funds page:

1. Goal Name
2. Account
   a. The account linked to your goal
3. Category
   a. The category assigned to your goal
4. Amount
   a. Enter an amount to transfer out of your completed savings goal. Be sure to delete the goal if you want to stop allocating funds to the goal.
5. To Account
   a. The account to which your funds will be transferred to.

Bill Pay

The Bill Pay feature of Online Banking is a very useful online tool for organizing a Member’s monthly bills. The feature can be used for paying bills electronically, tracking payments, and monitoring expenses in a safe and secure format. In order to use Bill Pay members must have a checking account, money market account, or savings account. Members will need to read and agree to disclosures the first time they access bill pay.

Bill Pay Dashboard

The Bill Pay dashboard will display all payees, the next 30 days of scheduled payments, and recent payments.

Clicking on a payee a member will be able to do the following:

- Make a payment
- Manage the payee’s information and details
- View payment history or scheduled activity
Adding a Payee

1. Click add payee button at the bottom of page or in the upper right corner of the page
2. Select business or person
   a. Persons can only be paid by check
3. Enter required information based on payee type
   a. Person
      i. Name
      ii. Payment Method
      iii. Select Funding Account
      iv. Click Next
      v. Enter Address
      vi. Click Add Payee
   b. Business
      i. Name
      ii. Zip Code
      iii. Select Funding Account
      iv. Enter Account Number
      v. Enter Address
      vi. Click Add Payee

Clicking on a payee, members can make a payment, manage, or view activity for that specific payee.

Making a Payment

1. Click on desired payee
2. Select Pay From account
3. Enter dollar amount
4. Select frequency
5. Select Start Date
6. Select Delivery Method
   a. There is a fee for expedited payments
      i. Check $20.00
      ii. ACH (Electronic) $9.95
7. Add Memo
8. Submit Payment

Note: Funds will leave the members account on the due date if the payment is electronic or when a payee cashes a check payment. If a check payment is being sent, the check will be sent out in the mail to the payee 5 days prior to the due date.

Managing a Payee
1. Select Payee
2. Click Manage
3. Click on the pencil icon to make changes for the following:
   a. Payee Information
      i. Nickname
      ii. Categories
      iii. Account Numbers
      iv. Address
      v. Phone Number
   b. Sender Information (Funding Account)

A payee’s status can be changed to Inactive or Active. If a payee is changed to inactive the payee will no longer be displayed in the Bill Pay Dashboard.

Note: Payees can only be changed to inactive if there are no scheduled payments

Payees can be deleted by clicking “Delete Payee”

Activity
A graph, payment history, and scheduled payments will display for the payee selected.

eBills
Some payees will have an eBill relationship with the bill pay. Once these payees are added, members will have the option to register for eBills. Members will be asked to provide merchant-specific information to continue with the eBill registration process. Once the information is entered, members will typically wait a couple of days before the registration is complete.
Set up eBills

1. If eBill is available for the payee, click sign up for eBill.

2. Click setup eBills.

3. Verify your account information on the Begin eBill Enrollment pop-up box by entering your security and authentication credentials.
4. Click the Continue button and complete the registration process.

Note: Once eBill registration is complete, eBill available will display on the payee.

Manage eBills

1. Click eBill Available or select payee, then eBills
2. To update your Payee Login information or Unenroll from eBills, click the Update eBill Enrollment button.
3. To update Autopay Settings (enable or disable autopay, choose a payment amount, delivery options, or the account from which to pull funds) in the Autopay Enabled section, click the Edit (pencil) icon.
4. For eBills with Pending payments, click the Ellipsis (...) dropdown menu to select View Bill, Pay Now, or Archive.

MultiPay
Members can make one-time payments to several payees in one transaction.

1. Select Payees
2. Select Pay from Account
3. Enter Dollar Amount
4. Select Deliver by Date
5. Click Submit

Scheduled
A calendar that displays a monthly total as well as a three-month outlook of scheduled payments.

Members can do the following:

- Edit single payments
- Manage recurring payments
- Edit recurring payments
- Cancel recurring payments
History
Members will be able to view their payment history for their payees.

![Payment History](image)

Message Center Widget
The Message Center provides members with the ability to compose (create), send, receive, and reply to secure messages to/from the Credit Union. The message center can be accessed by clicking on your name in the upper right corner and selecting messages. Notifications for unread message will be seen here. Once a response has been sent an email notification will be sent.

Inbox
Members can view messages and message threads, compose a new message, and respond to a message using the Inbox tab of Message Center. Message threads containing new messages will be highlighted.

![Message Center](image)
Compose a New Message
To compose a new message:

1. Click the Compose button on the Inbox tab of Message Center.
2. Select the message Subject from the dropdown menu.
3. Select the Account the message refers to from the dropdown menu.
   a. A Not Account Specific option is also available for general questions.
4. Type message in the message body section.
5. Optional: Click Attach Files link to attach files to the message.
   a. Attachments cannot exceed three files totaling 15 MB.
6. Click the Send Message button to send the message, or click the Cancel button to close the New Message window without sending the message.
7. A Message Sent success message will display.

Reply to a Message
To reply to a message:

1. Select the message thread you wish to respond to.
2. View the messages within the thread.
3. Type a response in the message.
4. Optional: Click the Attach Files link to attach files to the message.
   a. Important: Attachments cannot exceed three files totaling 15 MB.
5. Click the Send button to send the response.
6. A Reply Sent success message will display.
Message Actions
Members have the ability to mark a message as unread, read, or delete a message.

1. Click the Edit link to view the message actions.

2. Click the checkbox next to the message you wish to take action on.
   a. Note: Click the Select All link to select all messages in the inbox, or click the Cancel link to exit the message action options.

3. Select the desired action:
   - Click the delete (trash can) button to delete the message threads.
   - Click the unread (envelope) button to mark the message threads as unread.
   - Click the read (open envelope) button to mark the message threads as read.

4. A Message Updated success message will display.
Sent Tab
The Sent tab allows members to view and delete messages they have sent to the Credit Union.

Deleting a Sent Message
To delete a sent message:

1. Click the Edit link

2. Click the checkbox next to the message(s) to delete.
   a. Click the Select All link to select all messages in the sent box, or click the Cancel link to exit the message action options.
3. Click the delete (trash can) button to delete the selected sent messages.
4. A Message Deleted success message will display.
More Widget Options
Clicking on the More Widget will display hidden widgets. Members can click on any of the hidden widgets.

Check Services
Members have the ability to put a stop payment for a check or order new checks.

Stop Payment
Members can place a stop payment on a check if the specified check has not already cleared the account. Members must provide the account number, dollar amount, and the check number of the check. Stop payment requests performed in online banking can be seen here. If a stop payment is done in person at a branch or over the phone those stop payments will not be seen in online banking.

Placing a Stop Payment
1. Click New Stop Pay Request
2. The Add Stop Payment Request window will display
3. Select Account
4. Enter Check Number
   a. Range can be selected if there are multiple checks in a series
5. Enter dollar Amount
6. Click Search for matching transaction
   a. If there is a match a stop payment cannot be placed
7. Enter Payee NAME
8. Read and Agree to terms and conditions
9. Click Submit Request
Reorder Checks

Members can reorder checks by clicking on the order checks button. Members will be redirected to a third-party website to complete their order.

Members will need the following information:

- Your 13- or 15-digit account number as it appears on your checks today.
  - Can be found in online banking, under the “Account Details” tab of your checking account.
- PMCU Routing Number (307074535)
- Your zip code

Budgets Widget

Members have the ability create and monitor budgets. To create a budget, members will have to choose an account that will be associated with the budget. Members can assign income and expense transaction categories with the budget.

Creating a Budget

1. Name your budget
2. Select accounts for your budget.
   a. At least one account must be selected.
3. Add categories and amounts to the Expenses and Income sections by selecting the Add Category button from either section.
1. Choose an item from the Expenses Category drop down list and enter an amount. Select Manage Categories to create your own category.

Budget Summary

The budget summary page provides information about the selected budget. Use this screen to review alerts, balances, recent transactions, total income for the month, and total spending for the month for the accounts that are part of the selected budget.
Alerts will be issued when your spending exceeds the amount budgeted for a given category, or if your current spending habits may exceed your budget for the category. Advice is provided when you have gone over a spending category budget for three consecutive months.

Budget Spending
The spending page provides a detailed look at your spending habits compared to your budget over a selected time period. The current month will be the default, but this can be changed by selecting range.

The spending section of the page will show the following:

- **Total Budgeted**
  - Displays the sum of your categories for the selected time period
- **Actual**
  - Displays your total spending across all budgeted categories for the selected time period
- **Categories for budget**
  - Each category will have progress bar
- **Over Budget**
- **Under Budget**

A pie graph helps you determine where your money is going. Up to seven different spending categories are represented on the graph.
Income
The income page provides a detailed look at your actual income compared to your expected income over a period of time. The default will be for the current month, clicking on range will show more months.

Transactions
The transactions page can be used to review transactions associated with a specific budget. Members can edit transactions and do an advance search for specific transactions.
Settings

The settings section will allow members to adjust their current budget by any of the following:

- **Rename Budget**
- **Add additional Accounts**
- **Add, Adjust, or delete Categories**
  - Click add a category to add a new one
  - Enter a new dollar amount to adjust a current category
  - Click the “X” button to delete a category
- **Add, Adjust, or delete Income**
  - Click add a category to add a new one
  - Enter a new dollar amount to adjust a current income
  - Click the “X” button to delete income
- **Delete Budget**
- **Create a New Budget**

Any changes made a member must select “Update Budget” in order to save any changes.
Business Admin Widget
The Business Admin widget provides business users with the tools to set up, maintain, and manage the various aspects of their business. The Business Admin widget also serves as the hub for Authorizations, Roles, and Users.

- Master user - This user type is the primary business user with permissions to access and manage sub users. There can only be one master user per business.
- Sub user – This type of user is may be assigned different roles with varying levels of permissions.

*Note: A Sub User can have the same permissions as a master user.*

Roles
Roles determine the set of features a sub user is allowed to use, the accounts they can work with while in online banking, transaction limits associated with specific transaction types, and whether or not sub users are able to approve transactions. A role may be applied to more than one sub user, allowing your business to create business-specific roles that cover the access requirements of multiple individuals at the business.

*Important: A role must be created before a master user can add sub users in online banking.*

*Note: If the business is a single user entity, they are not required to create a role.*

Creating a Role
1. Click the Roles tab in the Business Admin widget.
2. Click the Add a Role button
3. The Add a new role window will display
4. Enter a description for the role
5. Click create role
Editing a Role

1. Click the Roles tab in the Business Admin widget.
2. Select a role from the role list.
3. Click the pencil icon next to the section name to edit
4. Click Save Changes once edits are complete

Delete a Role

1. Click the Roles tab in the Business Admin widget.
2. Select a role from the role list.
3. Click the Delete Role at the bottom of page
4. Click “Yes, delete role”

Note: If a role is currently assigned to a sub user, the role cannot be deleted until all sub users with the role are assigned another role.

Permissions

There are two types of role permissions in the Business Admin widget:

- Role Level permissions - permissions that apply to the sub user and typically turn on or off specific functionality for that sub user.
- Account Level permissions - permissions that apply to the sub user's account and typically turn on or off specific functionality for a given account.
Assign Role Permissions

1. Click the Roles tab in the Business Admin widget.
2. Select the role to assign permissions to.
3. Click the pencil icon next to the Permissions section.
4. Click the checkbox next to the permission to add to the role or select all for all permissions.
   a. Clicking on a checked checkbox next to a permission will remove the permission from the role.
5. Click the save changes.

Note: To view a description of the permission, hover over the checkbox or click the list icon to view descriptions for all business banking permissions.
Accounts and Limits

Adding Accounts to a Role

1. Click the Roles tab in the Business Admin widget
2. Click the Add Accounts button
3. Assign Account Permissions will display
4. Click the checkbox next to each account you wish to give permissions to or click select all to add all account permissions.
5. The Assign Accounts to this Role will display
6. Select which accounts you want to assign to the role.
7. Click Assign Accounts

Edit Account Permissions

1. Click the Roles tab in the Business Admin widget.
2. Click the pencil icon for the Accounts section
3. Click on the checkbox next to the permission you wish to add or remove.
4. Click Add Accounts to add any additional accounts (Optional)
   a. Click on the checkbox next to the permission you wish to add
   b. Click Assign Accounts
   c. Select Accounts
   d. Click Assign Accounts
Remove Accounts

1. Click the Roles tab in the Business Admin widget.
2. Click the pencil icon for the Accounts section.
3. Select the account you wish to remove in the accounts list.
4. Click Remove
5. Click Yes, remove account

Limits

Limits allow master users or any authorized sub user to set thresholds for different transaction methods in different limit categories and set durations that apply to sub users’ transactions. Each role supports three sets of cumulative limits (daily, weekly, and monthly).

Adding Limits to a Role

1. Click the Roles tab in the Business Admin widget.
2. Click the Edit pencil icon for the Limits section
3. Click on the check box next to method you wish to assign limits
4. Enter the limit amount for each category
5. Click Save

Note: Please review the following definitions

- **Authorized limit**: Max amount that can be submitted without additional authorization or approval
- **Max limit**: Max amount users with this role are able to submit
- **Can authorize**: Max amount users with this role can authorize for other users.
Sub User Management
The Business Admin widget allows master users and sub users with the Manage Users and Roles role permission to add, edit, and delete sub user.

Note: A role must be created prior to creating a sub user

Create a New Sub User
1. Click the Users tab in the Business Admin widget.
2. Click the Add a User button.
3. The Add a new user window will display.
4. Enter a Username using a minimum of 6 characters.
5. Click the Check Availability button.
6. Enter the new sub user’s First Name.
7. Enter the new sub user’s Last Name.
8. Enter the new sub user’s Email address.
9. Select the new sub user’s Role from the dropdown menu.
10. Click the Create User button to create the new sub user.
Note: When creating a new sub user, a temporary password is sent to the sub user. The master user must communicate the username that was created for the sub user in order for the sub user to complete the registration process.

**Editing a Sub User**
A master user can edit a sub user’s contact information (name, email, phone, and address) and role. Additionally, a master user can reset a sub user’s password or security questions.

**Edit a Sub User’s Contact Information**
1. Click the Users tab in the Business Admin widget.
2. Select the sub user from the user list.
3. Click the pencil icon next to the section to name or contact info.
4. Make desired edits.
5. Click Save Changes.

**Change a Sub User’s Role**
1. Click the Users tab in the Business Admin widget.
2. Select the sub user from the user list.
3. Click the Edit pencil icon next to the role section.
4. Click the radio button next to the role to assign to the sub user.
5. Click Save Changes.

**Reset a Sub User’s Password**
1. Click the Users tab in the Business Admin widget.
2. Select the sub user from the user list.
3. Click the pencil icon next to the Reset Password section.
4. Select how to send the temporary password.
   a. Email Address
   b. Phone Number (SMS)
5. Enter reason for the password reset.
6. Click Save Changes.

**Reset a Sub User’s Security Questions**
1. Click the Users tab in the Business Admin widget.
2. Select the sub user from the user list.
3. Click the pencil icon next to the Reset Security Questions section.
4. Enter a reason why the security questions are being reset.
5. Click Submit

Delete a Sub User
1. Click the Users tab in the Business Admin widget.
2. Select the sub user from the user list.
3. Click Delete User.
4. Click Yes, delete user

Transaction Authorizations
The authorizations feature enables business users to review and approve any transaction requests for release and processing. Only business users with the following role permissions are allowed to authorize transactions: Authorize Transfers Internal and External. Business users assigned to roles that do not include these permissions are not able to see the Authorizations tab in the Business Admin widget.

Transactions in a Needs Authorization status can be authorized or rejected using the Authorizations tab in the Business Admin widget.

Business users with the proper permissions can:
1. Sort pending authorizations by date, or amount.
2. Click the Show Limits button to view the authorization limits for your role.
3. Click on the transaction to view details

Note: A number will display next to any transaction types indicating the number of transactions that are in a Needs Authorization status.

Authorize a Transaction
1. The Business Admin widget defaults to display the Authorizations tab.
2. Select the transaction type to view transactions within the transaction type that are in a Needs Authorization status.
3. Click the checkbox next to the transaction to authorize.
4. Click the Authorize button to approve and submit the transaction.

Reject a Transaction
1. The Business Admin widget defaults to display the Authorizations tab.
2. Select the transaction type to view transactions within the transaction type that are in a Needs Authorization status.
3. Click the checkbox next to the transaction to reject.
4. Click the Reject button.
5. The Reject window will display.
6. Enter a reason why the transaction was rejected.
7. Click Reject
Authorization Alerts
Notifications can be set up when an authorization is needed. Please review the notifications section to setup an alert.

Locations Widget
The locations widget will show you PMCU, Shared Branch (Service Centers), or ATM locations on the map. Members can type in an address to find locations near them.

Calculator and Calendar Widget
A calculator and calendar are available for members to use.

Statement & Notifications Widget
The statement & notifications widget can be used to subscribe or unsubscribe for electronic statements. Clicking on the statements tab will allow a member to view their statement.

Once a member clicks view statements, they can do the following:

- View eStatements or Tax Documents by clicking on the available links
- Change the email address associated with eStatement alerts/notifications
- Choose to Enroll or Discontinue in the eStatement service

In order to view your eStatements, you will need to have Adobe Acrobat installed on your computer. Download it by clicking here.
Checking Tracker Widget
Members will be able to track their current and prior month status for Earning Big on their checking account(s). Members must be enrolled statements, have a direct deposit of $500 dollars, and use their debit card at least 25 times. *Note: ATM transactions do not count*

To access the data for a prior month, follow the instructions below:

1. Select the account from the drop-down field at the top.
2. By default, you will be presented with the current qualifying period.
3. Click on the qualifying period in question from the right-hand side.
4. Review the data presented.
Quick Apply Widget
Members can apply for a new share account or mortgage. Members will need to read and agree to the disclosures before proceeding with the application.

Applying for an Account
1. Click Apply Now in the Shares section
2. Choose the product you wish to apply for
   a. Checking
   b. Savings
   c. Certificate
3. Once you have clicked on the product, you will be taken to products page to select the desired product.
4. Click apply on the desired product.
   a. If you do not qualify for a product, you will see the following message:
      i. Ineligible Account Type
5. Verify your contact information is correct and select continue

6. Enter opening deposit amount
7. Select the funding source
8. Select continue

Applying for a Mortgage

1. Click Apply Now in the Mortgage section
2. A new window will open
3. Complete the application
Card Management Widget
The Card Management widget allows members to view information about their debit and credit cards, control the use of these cards, and maintain their status without having to contact the Credit Union directly.

Clicking on a card will allow a member to view do the following:

- Freeze/Unfreeze Card
- Add Travel Notices
- Replacement Options

Freezing or Unfreezing a Card

1. Click on debit or credit card
2. Click on the gear icon
3. Click Freeze this card
   a. Click unfreeze to unblock
Add Travel Notices
1. Click on debit or credit card
2. Click the down arrow icon
3. Enter a start date and end date
4. Select Domestic or International
   a. Select State if Domestic
   b. Select Country if International
5. Select Additional Card (Optional)
6. Click Save

Ordering Replacement Card
1. Click on debit or credit card
2. Click the down arrow icon
3. Select any of the following:
   a. Lost
   b. Stolen
   c. Damaged
4. Click Report as based on the reason you selected
Objects Pay Widget
Members will be able to opt in or out of objects pay for eligible checking accounts. Members must read and agree to the disclosure before an election can be saved.

Overdraft Protection Widget
Members will be able to set up overdraft protection for their accounts in the event an item is presented and there are not enough funds to cover the transaction. An example would be adding a money market account to cover the checking account.

Setting up Overdraft Protection
1. Click “Select backup accounts” for desired account
2. Click “Add as backup” in the Available Accounts section
   a. The added account will appear in the overdraft protection accounts section
      i. Clicking on the trashcan icon will remove the account
3. Read and Accept Disclosure
4. Click Save Changes
FICO Score

Members are able to access their FICO Score via the FICO widget. A disclosure will need to be accepted before a member can view their FICO score. A member can opt-out of receiving their FICO score at any time. Entity and joints will have their own score. FICO scores will be updated quarterly.

Note: This will not affect your credit score.
Alerts

Members can configure alerts for their account via the Alert widget. Alert notifications can be sent via Email, SMS (Text), or Push (Mobile). The following alerts can be set up:

- General Alerts
- Mobile Deposit
- Accounts
  - Automatic Deposit
  - Automatic Withdraw
  - Balance
  - Balance Summary
  - Check Cleared
  - Insufficient Funds
  - Transaction
  - Transaction Description
- Transfers
  - External Transfer Account Blocked
  - External Transfer Canceled
  - External Transfer Submitted
  - Transfer Fails
  - Transfer Succeeds
- Savings Goals
  - Goal Completed
  - Goal Endangered
- Budgets
  - Budget Category Exceeded
  - Budget Exceeded
  - Budget Summary
- Authentication
  - Online Banking Access
Settings
Members are able to view and update settings throughout their online banking environment. Members can access the settings area by clicking on their name in the upper right corner and click settings or click the more widget and click on widget settings. There are several different tabs within the settings widget:

- Profile
- Security
- Themes
- Widgets
- Contact
- Accounts
- Shared Access
- Applications

Profile
Members can configure profile information for the following:

- Nickname
- Time Zone
- Profile Picture
- View Recent Login activity

*Note: Using a 3rd party aggregator such as Mint, Quicken, etc. will show as recent login activity via Chrome. Clicking on the pencil icon allows a member to make changes*

Security
Members can configure security details for the following:

- Username
- Password
- Turn Off/On Two-Factor Authentication
- Manage Remembered Devices

*Note: Clicking on the pencil icon allows a member to make changes*

Themes
Members can personalize the look of their online banking. Clicking activate on a theme will change the theme.

Widget
Within the Widget settings tab, members can specify which widgets are to appear in their favorites list and the order they appear. Only five widget options can be selected as a favorite. Clicking on the star
icon will add or remove a widget as an option. Clicking on the reorder favorites button members can drag and drop widgets in the preferred order. Members can also hide widgets by clicking the (X) button. Hidden widgets will be displayed in the available section at the bottom of the screen. Clicking add on a hidden widget will move it to the active widgets.

Contact
Members can edit their contact info for the following:

- Address
- Phone Number(s)
  - Can opt in to SMS text messages. This must be done to receive text alerts and messages
  - Can designate preferred phone number
- Email Address(es)
  - Can designate preferred email if there are multiple
Online Banking – User Guide

- Clicking add email will add an additional email address
  - Can delete emails if there are multiple
  - Can create a nickname

Note: Clicking on the pencil icon allows a member to make changes

Accounts
Members can create nicknames, color code, or hide an account. This can be done by clicking on the pencil icon next to the account name. Once you have completed any changes, click save.

Note: Nicknaming an account within Online Banking and will not appear on Member Statements, Notices, or other Credit Union documentation.

Members will be able to add external accounts by clicking on “Link an External Account” Please review the external accounts section for steps to add an external account.

Shared Access
Members can share their accounts with another user. Sharing an account can be done only with an account the member is registered to in online banking.

Adding a Shared User
1. Click on Settings
2. Click the Shared Access tab, click add a user.
3. Enter the recipient’s first name and last name in the corresponding fields.
4. Enter the email address
5. Check the box(s) next to the permission(s) you want to allow.
6. Click Save; a confirmation is displayed.
7. Confirm the information and check the box to acknowledge sharing the account(s).
8. Click Confirm.

The invitation will show as “Invitation Pending” until confirmed. Once the shared user clicks on the link in the invitation, they will need to choose how to access the account by one of the following:

- Already an online user log in
- Register
- Sign in as a guest
No shared access users

Shared Access allows users certain access to your Premier Members CU accounts. Based on the permissions you set, users can view, transfer to, transfer from, or pay bills. Click below to add users and set permissions for your Premier Members CU accounts. You may only invite users that are members with us.

Add a new user

First Name
Johnny

Last Name
Testcase

Email Address
JohnnyTestcase@Fake.com

Confirm Email Address
JohnnyTestcase@Fake.com
### Choose permissions

<table>
<thead>
<tr>
<th>Checking - 2 accounts</th>
<th>All permissions</th>
<th>View account</th>
<th>View Transactions</th>
<th>Transfer into</th>
<th>Transfer from</th>
<th>Pay bills</th>
</tr>
</thead>
<tbody>
<tr>
<td>EARN BIG FREE CHEC...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0002 CHECKING</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Savings - 3 accounts</th>
<th>All permissions</th>
<th>View account</th>
<th>View Transactions</th>
<th>Transfer into</th>
<th>Transfer from</th>
<th>Pay bills</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONEY MARKET</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SINGLE HSA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000 SAVINGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Retirement Accounts - 1 account</th>
<th>All permissions</th>
<th>View account</th>
<th>View Transactions</th>
<th>Transfer into</th>
<th>Transfer from</th>
<th>Pay bills</th>
</tr>
</thead>
<tbody>
<tr>
<td>0003 SAVINGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mortgages - 2 accounts</th>
<th>All permissions</th>
<th>View account</th>
<th>View Transactions</th>
<th>Transfer into</th>
<th>Transfer from</th>
<th>Pay bills</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mortgage Loan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mortgage Loan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Save] [Cancel]
Applications

Members are able to view and revoke access to authorized applications. An example of an authorized application is your Premier Members CU mobile banking application. An example of when you may want to revoke token(s) is if you have a device that is lost or stolen.

Frequently Asked Questions

1. **What are the benefits of logging on to Online Banking with a Username over an Account Number?**
   
   a. A Username can be customized, to be easy for the Member to remember.
   
   b. The Username can be letters, numbers, special characters, or a combination. Usernames can be letters, numbers, special characters or a combination. Usernames cannot contain a member’s: Social Security Number/Tax ID, Member Number or Account Number. **Note: Only the following special characters can be used: ^[-_.]{,}$**
   
   c. A Username is more secure - in that when using the internet in public locations, a Member is not required to expose their PMCU Account Number.

2. **Do Members have to change their Username from being their PMCU Account Number?**
   
   a. No, Members do not have to change their Username to be something different from their PMCU Account Number; however a Username must be at least 6 characters in length. They can continue using their Account Number as their Username as long as they adjust it to have at least 6 characters. At any point, they can customize their Username in Settings>Security>Edit Username.

3. **Why is the Password on a separate page?**
   
   a. Having the Password on a separate page allows PMCU to display the Member’s Username back to them for visual confirmation – before they provide the second piece of their Online Banking Log On credentials.

4. **Why does my Account Nickname not show up on my statement?**
   
   a. Account Nicknames are only within Online Banking and are not used by the Credit Union.
5. Can a PMCU Member Service Representative see my Account Nickname?
   a. Your Account Nickname will be stored with your Share or Loan; however, it is not easily
      accessible by PMCU staff.

6. Can I create more than one Budget for an account?
   a. The Spending Report function associates one account with one Budget and does not
      differentiate between funds that are assigned to Budget 1 and Budget 2; therefore, you
      can have only one Budget linked to one Account.

7. How do I see all of my Budgets when I have more than two?
   a. Only one Budget can be viewed at a time. Click the drop-down box called “Select
      Budget” to view any additional budgets you have.

8. Will my Bill Pay transactions carry over into my Budget?
   a. You may need to manually assign a category to your Bill Pay transaction. Go to the
      transactions screen while in your budget to do this. Once you have assigned a category
      the Bill Pay transaction will count towards your spending budget.

9. Will my Categories download in a file so that I can upload them into personal financial
   management software like Quicken?
   a. Members can download transactions; they cannot at this time download Categories or
      categorized transactions.

10. Within Budget under transactions, can I set up my own rules for how transactions are
    categorized?
    a. Transactions are automatically categorized based on the description of the transaction
       or the Merchant Code of the transactions. Members can re-categorize a transaction by
       selecting a new category in the Category list.

11. Within Spending Reports, can I split a transaction across multiple spending categories?
    a. Yes, you can. There is a split option once you have clicked on category.

12. Can I have more than one Savings Goal to an Account?
    a. Yes, you can have multiple Savings Goals for an account.

13. What is a micro transfer?
    a. It is an amount less than $1 that is used to validate an Account at another Financial
       Institution.

14. Can I use the External Accounts Transfers option to transfer to my brother in another state?
    a. This option is set up to transfer between two Accounts, which you own. The PMCU
       Account and an Account at another financial institution. If you would like to transfer
       money to another individual, to an Account that you are not an owner of, we suggest
       that you use PMCU’s Bill Pay system.

15. Are there any fees associated with transferring Outside of PMCU?
    a. There is no fee.

16. Are there any fees for using PMCU’s Bill Pay service?
    a. PMCU does not charge a fee for this service.

17. Can I make payments (transfers) to people through Bill Pay, not just businesses?
    a. Yes, you can make payments to people, businesses, charitable organizations, etc.
       through Bill Pay.